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Resizing Images in Photoshop CC 
Roy Killen, EFIAP, GMPSA, GMAPS, APSEM 

These notes assume that you want to produce an image that fits the following size 
requirements:


Maximum pixels dimensions 1920 x 1200


Maximum file size 2MB.


These are the size limits for files submitted to digital image competitions for Belmont 16s 
Photography Club and competitions such as the Lake Macquarie National Exhibition of 
Digital Photography.  However, the procedures described here can be adapted to produce 
images of any size.


The first thing to understand is that the maximum pixel dimensions of 1920 x1200 means 
that the image must fit within a rectangle that is no more than 1920 pixels wide and no 
more than 1200 pixels high when the image is viewed in its correct orientation. Note 
that you images will be judged in the orientation you submit them - they will not be rotated 
for judging.


The image you submit to the competition may be smaller than this, but you should always 
try to have at least one of the dimensions at its maximum. If both dimensions are smaller 
than the maximums that are allowed you will be at a disadvantage when your image is 
judged. So, you should aim to have one of the following:
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a) an image 1920 x 1200 pixels, or


b) an image 1920 pixels wide but less than 1200 pixels high, or


c) an image 1200 pixels high and less than 1920 pixels wide.


If you have a square image it can be no more than 1200 x 1200 pixels. 


If you have a portrait format image it can be no more than 1200 pixels high - so naturally it 
will be less than 1920 pixels wide.


It does not matter what size image you start with, you can always resize it to fit within the 
1920x1200 pixel limits. However, you should remember these points:


a) 1920 x 1200 is an aspect ration of 16:10 and this is not the same as the aspect ratio of 
the files saved by most digital cameras.


b) If you start with an image that is a different aspect ratio (perhaps 4:3) and you want to 
make your image exactly 1920 x1200 pixels without distorting it, you will have to crop 
the image to the 16:10 aspect ratio.


c) If you start with an image that is a different aspect ratio (perhaps 4:3) and you do not 
want to crop it (or distort it), you will have to choose to either make the width 1920 
pixels and the height something less than 1200 pixels, or make the height 1200 pixels 
and the width something less than 1920 pixels.


d) If you start with an image that has an aspect ratio of anything other than 16:10 and you 
force it to be 1920x1200 pixels without cropping it, it will become distorted. 

All image editors will allow you to crop and/or resize images. These notes explain how to do 
it in Photoshop CC. Other programs, or other versions of Photoshop, will require different 
procedures but the basic principles are the same.


Let’s assume you have opened an image in Photoshop that is 4928x3280 pixels (or 
whatever size image your camera produces). For example:
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Quite obviously, this is an image that would benefit from some heavy cropping, so you 
would normally do that before making other adjustments tot he image. There are several 
ways to crop in Photoshop but, keeping in mind that your image will eventually be 
1920x1200 pixels it is useful to use a cropping technique that will produce the 16:10 aspect 
ratio that we want. (At this stage we are not concerned about the actual pixel dimensions, 
just the aspect ratio.)


The steps to follow to crop to an aspect ratio of 16:10 are:


1. Select the Crop tool from the toolbar: 


2. At the top left of the screen you should now see the options for the Crop tool. The 
second option from the left is a small window that shows the aspect ratio selected for the 
crop. 


If this does not already show 16:10 (which it probably will not) then click on the downward 
facing arrow next to the displayed crop ratio and select 16:10 or 1920:1200 from the 
dropdown list.  


If neither of these ratios appears in the dropdown list you 
can create a new ratio and save it.  Just type “16” and 
“10” in the boxes to the right of the box that shows the 
aspect ratio (where they are shown faintly in the graphic 
above); then select “New Crop Preset” from the 
dropdown list of aspect rations. The 16:10 crop ratio will 
then appear whenever you select this drop down list - this 
will save you time when doing future crops.


Once you have selected the required crop ratio you will 
see an outline of the crop area on the image and there will 

be “handles” at the corners and sides of this crop area that you can grab and drag. As you 
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drag the crop area it will maintain the aspect ratio that you selected. At this stage we are 
still not concerned about the actual pixel size of the cropped area, just its aspect ratio.


In my example, I dragged out a crop area that just happened to be 2218x1386, pixels 
(Photoshop shows this size as you create the crop area) so the screen looked like this:


I then chose to add a little more tension to the image by slightly rotating the crop area:
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I then hit return/enter to accept the crop it gave me this:


Of course, I could have chosen many other (perhaps better) ways to crop the image, and 
you generally will not need to rotate the cropped area, but do not be concerned about that 
as this is just an example.


Normally I crop my images before I process them, particular images such as this example 
that obviously need heavy cropping. I can then work on the part of the image I want to keep 
without being distracted by anything else in the image. For images where I want to retain 
most of the captured image area I take a different approach and process/edit the image 
before cropping it. Either way, after the cropping I have an image that is the correct aspect 
ratio but the pixel dimensions will still be too large (unless I made a very heavy crop). You 
should save the image at this time (as a Photoshop file 
with layers if you have created any layers in the editing 
process) and then resize it before saving the final version.


To resize the image, select Image>Image Size from the 
menu:
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This will open the resizing window, which in Phototshop CC 2015 on a Mac looks like this:


You should note the following:


a) The pixel dimensions 
are currently shown 
as 2218x1386, so 
only a slight 
reduction in size is 
needed in this case. 
Because of this it is 
safe to leave the 
“resampling” set on 
“Automatic”. If you 
are doing more 
drastic reductions (or 
enlargements) you 
might want to 
choose one of the 
other options from 
the “resample” dropdown menu.


b) There is a “link” symbol connecting the words “Width” and “Height”. This tells you that 
Photoshop will keep the aspect ratio of the image when you resize it. If you click on this 
link symbol it will disappear and you must NOT do that or the resizing will distort your 
image. [In earlier versions of Photoshop you actually had to tick a box called “Constrain 
Proportions” so that the aspect ratio would not change.]
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c)  Opposite “Fit To” is says “Original Size”. We don’t want to do that. We want to change 
(reduce) the size. So all you need to do is type “1920” into the Width box (or 1200 into 
the Height box) and the other dimension will change by the appropriate amount 
(because the link constrains the proportions). When you do this, the “Fit To” message 
will change to “Custom”. Make sure that the dimensions are shown in “Pixels”, not cm 
or inches or something else.


d) You could ignore this step, but 
the first time you resize an 
image in this way it is worth 
saving this custom 1920x1200 
setting as a preset. 


This is easy to do. Just click 
on the arrow beside the word 
“Custom” and from the 
dropdown menu select “Save 
Preset”. 


Next time you want to resize 
an image to 1920x1200 pixels 
you can just select this preset instead of typing in the width or height. It will prevent you 
from making mistakes such as resizing to 1200x1920 instead of the correct 1920x1200.


e) The final thing to note in the Image Size window is that there is an option for changing 
the Resolution of the image. (In this example it is shown as 360 pixels/inch which is the 
correct setting if you were going to print the image on an Epson inkjet printer.) However, 
this setting can be ignored for images that will be shown on a screen or projector. The 
resolution will make no difference to the size or appearance of the image on the screen, 
it just matters when you are printing (which will be explained later).


NOTE:

If you uncheck the “Resample” check 
box you will see that the “link” locks 
together three things - Width, Height 
and Resolution. Changing any one of 
these will change the other two. 


This will not matter for digital images 
that will be projected but it does matter 
if you are resizing images for prints. If 
the resampling is unchecked, changing 
width or height will change resolution 
and you do NOT want that to happen if 
you are printing the image.
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For printing, you can set up your favourite settings for resizing images (width, height and 
resolution) and save those settings as a preset using the same technique described 
previously.


SAVING IMAGES FOR COMPETITIONS 

After you have resized your image to the correct pixel dimensions you should save it as a 
PSD file with a different name than the one you used when you saved it before resizing. You 
will then still have your original file and you will be able to resize it to different dimensions 
for other purposes if you need to.


To save the file in a format that is ready for uploading to a competition you need to :


a) converted the image to the sRGB colour space if it is not already in that colour 
space


b) save the image as a JPEG file with an appropriate file name


c) make sure the saved file is less than 2MB (file size)


d) save the file in a location that you have set aside for your competition files.


The first step, converting to the sRGB colour space must be done BEFORE you attempt to 
save the file. 


From the Photoshop menu select Edit>Convert to Profile. 


Make sure you select “Convert to profile” and not 
“Assign Profile”. 


If you are wondering why you need to do this, the 
answer is fairly simple. Regardless of whether the 
competition you are entering will display the images 
on a computer monitor or through a digital projector 
the files need to be in the sRGB colour space to 
display your colours accurately. The files from your 
camera may or may not be in the sRGB colour space. 
Also, if you are saving RAW files in your camera, the 
RAW conversion process in Adobe Camera RAW or Lightroom or whatever RAW converter 
you are using may be set to produce files in RGB or ProPhoto or some other colour space.


When you select “Convert to Profile” from the Photoshop menu it will open a window 
similar to that shown on the next page. 


In the Source Space it shows the current profile (Adobe RGB in this example). If this already 
shows sRGB you can click “Cancel”.  Otherwise go to the Destination Space section and, if 
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it does not already show 
sRGB then click on the 
small arrow and select 
sRGB from the dropdown 
list. (Note: it will probably 
show sRGB IEC61966-2.1 
and that is what you 
want.)


The Conversion Options 
should be the same as 
those shown here; if not, 
select those options from 
the dropdown lists. Then 
press OK.


The file is now ready to save. 


From the main menu, select File>Save As and navigate to the folder/directory in which you 
want to save the image. This opens a dialogue window that will look something like this:
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The save dialogue will look a little different if you are using a Windows computer, but the 
same options will be there.


You need to do five things:


1. Type the name of the file (same as your image title) in the space next to “Save As”.


2. Select JPEG from the “Format” drop down list.


3. Make sure there is a tick in the “Embed Colour Profile” check box.


4. Make sure you have navigated to the  folder where you want to save the file.


5. Click on “Save”.


That’s it. The image is now saved and ready to upload to the competition website.


Resizing images for printing 
When you are preparing images for use in digital competitions all that matters in terms of 
“size” is the pixel dimensions of the image and the file size. When it comes to printing 
images things are a little different.


When an image is printed there are two things that determine how large the print will be: the 
pixel dimensions of the image and the resolution at which it is printed. The file size has no 
effect on the size of the print (but it can affect its quality). 


The resolution describes how closely together the pixels are printed  - it is usually quoted in 
pixels per inch. For example, if an image is 3000 pixels wide and is printed at a resolution of 
300 pixels/inch the print will be 10 inches wide. If the resolution of that image is changed to 
360 pixels per inch the print will be only 8.3 inches wide.


The resolution (pixels/inch) that you need in order for a print to look good (smooth tonal 
transitions and no pixelation) depends on the size of the print and most importantly the 
viewing distance. As the size of the print increases, it is best viewed at a greater distance 
(so that perspectives look correct) and it needs less resolution to look satisfactory. 


It is generally agreed that the ideal viewing distance is around 1.5 to 2 times the diagonal of 
the print. So, for a 6x4 inch print (15x10 cm) the viewing distance should be about 30cm. 
For an A3 print (42x30 cm) the ideal viewing distance is about 75-100cm.


There are various ways of calculating what resolution a print needs to be to show the best 
possible detail at the ideal viewing distance. In practice, it’s not worth wasting your time 
doing an individual calculation for every print. It is much more practical to settle on a fixed 
resolution that you can use for all your prints that will be used under similar situations (such 
as club competitions). For club competitions you can assume that your large prints will be 
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viewed from a distance of 50-100cm by people with reasonable eyesight. However, judges 
may look much more closely. If the print is approximately A3 size then it would need to be 
printed at a resolution of at least 200 pixels per inch for the details to be clearly visible.  
However, this should be considered as a lower limit and it is worth taking into consideration 
the recommendations of your printer manufacturer.  


If you are printing at home on an Epson inkjet printer you will probably get the best quality 
results with a resolution of 360 pixels/inch. If you are printing on a Canon printer the best 
quality results will probably be obtained at a resolution of 300 pixels/inch.


If you are having your images printed commercially, you may need to talk to the printer to 
ascertain what resolution they prefer for images. Generally, it will be 300 pixels/inch 
although they may say something different, such as 240 pixels/inch. The other thing you 
need to ask the commercial printer is whether or not they resize images and change the 
resolution during the printing process. As with printing at home, the most important factor 
in determining print quality is going to be the number of pixels in the image.


Keep in mind that the surface on which a print is made can make a difference to how much 
detail is visible at typical viewing distances. Gloss and semi-gloss papers will generally 
show more detail than matte papers when the same image is printed on them. 


You also need to consider how the printer is laying down its droplets of ink. In the Printer 
Settings dialogue box in Photoshop you are able to select the ‘output resolution’. This is the 
number of dots per inch (dpi) of ink that the printer uses. Generally, inkjet printers give good 
results at 1440dpi. Higher print densities might give better results for high-key images. The 
number of dots per inch of ink that the printer uses to produce a print (the dpi) is 
independent of the resolution of the image (the ppi). 


The next section of these notes assumes that you are printing at home, so it describes how 
to get your images to the right pixel size and resolution for printing on an inkjet printer.


When you open an image in Photoshop you can check its pixel size and resolution by 
selecting Image>Image Size from the main menu. If this is an uncropped image, its pixel 
size will be whatever your camera produced, for example, 6000x4000 pixels. The resolution 
of the image will be whatever the EXIF information from the camera has it set to, or 
whatever resolution was set in Adobe Camera Raw if you are converting your RAW files 
with that software. Whatever the resolution is when you open the file in Photoshop does not 
really matter because you can change it to whatever you want in the Image Size dialogue 
box. 


In the following example the pixel dimensions of the image are 3280x4928 and because I 
intend to print it on an Epson inkjet printer the resolution is set to 360 pixels/inch.  With 
these settings it would print at a size of 23.1cm by 34.8cm. 
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PPI is not the same as DPI.



If I want to make a larger print (but at the same resolution) I will have to resize it by 
increasing the number of pixels in the image - this process is called “resampling”. You will 
notice in the screen shot above that the resampling box is ticked and the resampling is set 
to “Automatic”.  This means that if I increase the number of pixels in the image (by typing a 
larger number next to either ‘Width’ or ‘Height’ and the pressing OK, Photoshop will decide 
what mathematical process to use to enlarge the image. If I wanted to have more control 
over this I could click on the arrow next to”automatic” and select the process I wanted 
Photoshop to use. The options for resampling are:


When you resample an image to larger pixel dimensions, Photoshop has to create some 
new pixels based on the colour values of existing pixels. The resampling method 
determines how Photoshop does this and the options shown above give some indication of 
when to choose each one. If you are making only small adjustments to image size (say a 
10% increase in size) you might as well leave the resampling on “automatic” as the various 
methods of resampling will make little difference to the final result. However, if you want to 
make large changes (say a 50% increase in size) you might want to try several methods and 
see which one gives the best result for your particular image. 


Keep in mind that whenever you increase the number of pixels in an image by resampling 
you will loose some detail and sharpness because Photoshop (or whatever other program 
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you are using for resizing) has to create new pixels and “guess” what their colour and 
brightness should be. (See later example.)


For the previous example, I want to increase the height of the image from 34.8cm to 40cm. 
The height is the critical dimension in this case; the width will be taken care of automatically  
because I have checked to make sure that the width and height are linked:


If the width and height are not linked you need to click on the link 
symbol so that the aspect ration of the image will not change when 
you resize it.


I know from experience with similar images that the “Bicubic smoother” resampling method 
will give me a satisfactory result, so I select that resampling method, change the width or 
height units to cm (the other one will change automatically), type in 40 as the required 
height and click OK. 


You can see now that the number of pixels in the image has increased to 3773x5669 and 
the width and height are what I require for printing. Before printing, the image will require 
sharpening but otherwise it is ready to go.


How much should you enlarge an image? 
If you enlarge an image too much you will find that the print lacks detail and clarity; it may 
even start to pixelate. So, let’s assume you want to make an A3 size print. A3 paper is 
42x30cm so you could comfortable print an image that was 40x28cm and mount it easily. 
For this example, I will assume you are going to make the print at a resolution of 300 pixels 
per inch, which is equivalent to approximately 118 pixels per centimetre so the 40cm 
dimension of the image will need to be about 4720 pixels (40x118). So, before resizing the 
image you want to print you need to think about how much it will be enlarged.
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Let’s assume you want to make an A3 print from 
an image that is only 2000 pixels high (because 
you cropped the original image) - for example, this 
image of the whydah. 


Enlarging this image to 4720 pixels high may or 
may not produce a satisfactory result, depending 
on how I enlarge it. Here’s why.  You cannot see it 
in the small image but in the original image the 
bird had a catchlight in its eye. Zooming in to the 
pixel level on the 2000 pixel high image we can 
see that the catchlight is made up of just one very 
bright pixel and several others that are not quite so 
bright. There is also a fairly well defined ring 
around the bird’s eye. This is shown below.





If the image is enlarged to 4720 pixels high in Photoshop and I view the same size area of 
the image this is what the eye looks like:
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The pixels that have been created produce a distinct softening of the image. Where 
previously there were just two or three distinct tonal values between the lightest and 
darkest pixel in the bird’s eye there are now at least six distinct tones in the same region. 
The ring around the eye is also much softer. In this particular case, the image may still look 
sharp enough when printed but the greater the amount of enlargement the more chance 
there is that your image will become too soft as a print. 


Obviously your prints will not show the pixel level of detail that is in the above image. I am 
simply illustrating what happens when Photoshop creates pixels during an enlargement. 
You should be able to see that you will have to be cautious about trying to enlarge images 
too much.


If you try enlarging an image in Photoshop and you are not completely satisfied with the 
results of the print you have two alternatives (besides deciding not to enlarge it). One option 
is to print at a lower resolution, perhaps 240 ppi instead of 300 ppi. This can work well for 
images that do not contain a lot of fine detail, such as clouds and sunsets. It may not be a 
satisfactory approach for images with fine detail as those details may tend to be softened 
too much by the enlargement process. 


A basic guideline is this: if you use Photoshop to enlarge your images by more than about 
two times you can expect to see some deterioration in quality when you print the image at 
A3 size. Of course there are lots of other factors that influence print quality so my best 
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advice is to experiment with some test images and try to determine the limits of what you 
can do successful when printing at home or commercially. 


Another approach is to use a different process for enlarging. Because different programs 
use different 
enlargement algorithms 
(different ways of 
calculating the values 
of the pixels that are 
created) they can 
produce quite different 
results. One program 
(or Photoshop plug-in) 
that usually gives good 
results is ON1 Resize 
10 (which was  
originally called 
Genuine Fractals). It 
gave this result result:


You can see that this 
enlargement has much 
more well-defined 
boundaries between 
the light and dark areas 
so it will produce a 
more detailed print than the enlargement done in Photoshop.


Please email me if you find any errors in these notes or if you want to suggest ways in 
which they could be improved. 


Roy Killen	 	 

Email: roykillen@mac.com

12th November, 2017
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